
1SLVU681A–February 2012–Revised July 2019
Submit Documentation Feedback

Copyright © 2012–2019, Texas Instruments Incorporated

DRV8818EVM Evaluation Module

User's Guide
SLVU681A–February 2012–Revised July 2019

DRV8818EVM Evaluation Module

This document serves as a supplement to the DRV8818 data sheet. It details the hardware
implementation of the DRV8818EVM evaluation module (EVM).
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1 Block Diagram

1.1 Introduction
The DRV8818EVM is a complete solution for evaluating the DRV8818 micro-stepping, bipolar stepper
driver. It includes a USB link to provide easy control from a personal computer (PC), a MSP430
microcontroller that interprets serial commands from the PC and generates control signals to the driver
device, and the DRV8818 device with access to all signals for a complete evaluation.

1.2 Power Connectors
The DRV8818EVM uses a combination of terminal blocks and test clips for the application and monitoring
of power. The only power rail that the user must supply is VM for the device’s power stage. VDD for logic
levels is internally generated from the USB connection.

Users must apply VM (8 V to 35 V) according to data sheet recommended parameters.

1.3 Test Stakes
Every pin on the device has been brought out to a test stake. A label on the silkscreen identifies each
signal.
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1.4 Jumpers
Two styles of jumpers are on the DRV8818EVM: two-pin jumpers and three-pin jumpers.

Users can configure three-pin jumpers independently from other two- or three-pin jumpers. However, two-
pin jumpers must all be closed or left open.

1.4.1 VREF SELECT, JP1
To configure the VREF SELECT jumper: (a) Select an analog voltage derived from VDD through a voltage
divider implemented as a potentiometer R4. (b) Select an analog voltage derived from the MSP430’s
digital-to-analog converter (DAC) channel 0 (DAC0). Set as the following inset shows in (b) if you want to
use the GUI to control the VREF voltage.

1.4.2 DECAY SELECT, JP6
To configure the DECAY SELECT jumper: (a) Select an analog voltage derived from VDD through a
voltage divider implemented as a potentiometer R6. (b) Select an analog voltage derived from the
MSP430’s DAC channel 1 (DAC1). Set as the following inset shows in (b) if you want to use the GUI to
control the DECAY modes.

1.5 Motor Outputs
Users can connect the bipolar stepper motor into the DRV8818EVM in three ways: four-pin header (J2),
four-position terminal block (J3), or test clips. Each connection style offers identical connectivity to the
device’s output terminals. The recommended way, however, is to use the header or terminal block
because the test stakes traces are of low-current handling capability.

2 GUI Software Installation
The following section explains the location of files and the procedure for installing the software correctly.

NOTE: Ensure that no USB connections are made to the EVM until the installation is completed.
The installer will also install LabVIEW RTE 2014 and FTDI Driver, along with the GUI.

2.1 System Requirements
• Supported OS – Windows 7 (32 Bit, 64 Bit). The window text size should be Smaller-100% (Default)
• Recommended RAM - 4 GB or higher
• Recommended CPU Operating Speed – 3.3 GHz or higher

2.2 Installation Procedure
The following procedure helps you install the DRV8818 GUI

1. Double click on the Setup_DRV8818_EVM.exe as shown in Figure 1.
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Figure 1. Setup_DRV8818_EVM.exe

2. The screen shown in Figure 2 appears, indicating installer initialization. Click the Next button.

Figure 2. Installation Initialization

3. In the newly open installation pop-up window, click Next. The license agreement will be displayed.
Please, read through it carefully and enable the "I Accept the Agreement" radio button and press Next.
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Figure 3. License Agreement

4. A screen as shown in Figure 4 appears, displaying the license agreement of National Instruments.
Please read through the agreement carefully and enable the “I Accept the License Agreement” radio
button and press the Next button.

Figure 4. NI License Agreement

5. Set the default directory for the GUI Installation and click Next.
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Figure 5. Installation Directory Screen

NOTE: It is highly recommended to keep the default values as provided in the installer.

6. A screen as shown in Figure 6 appears. This screen is to select the components to install. Select the
Components to Install and Click Next to continue installation. The LabVIEW RTE component checks
out if the LabVIEW RTE 2014 is already installed on the PC.

Figure 6. Component Selection

7. If LabVIEW RTE is selected as a component to install, a screen appears as shown in Figure 7.
Configure the proxy settings as required. This screen is to download the LabVIEW RTE 2014 from
ni.com, Click Next to continue the installation.
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Figure 7. Configure Proxy

8. A screen as shown in Figure 8 appears. Click Next to begin the installation.

Figure 8. Ready to Install

9. If the LabVIEW RTE 2014 is selected as a component to install, LabVIEW RTE downloads and
performs a silent mode installation.
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Figure 9. Downloading RTE

10. Once the Download completes, LabVIEW begins with the self-extraction as shown in Figure 10.

Figure 10. LabVIEW RTE Self Extraction

11. A Screen appears as shown in Figure 11. It initializes the LabVIEW RTE Installation.
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Figure 11. LabVIEW RTE Installation Initialization

12. A display as shown in Figure 12 appears which indicates the progress of LabVIEW RTE installation.
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Figure 12. Installation of LabVIEW RTE in Progress

13. Once the LabVIEW RTE 2014 is installed, DRV 8818 EVM GUI component installs.
14. After DRV8818 Installation, FTDI Installation begins. A screen as shown in Figure 13 appears, click

Extract to proceed.
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Figure 13. FTDI Installation Initialization

15. A screen as shown in Figure 14 appears, click Next to proceed.

Figure 14. Driver Installation Wizard
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16. The License Agreement appears on screen as shown in Figure 15.
17. Read through the License Agreement carefully and enable the “I Accept this Agreement” radio button

and Click on Next.

Figure 15. License Agreement for FTDI Driver

18. Click Finish to complete the Driver Installation.
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Figure 16. Driver Installation Completion

19. Figure 17 appears denoting the completion of DRV8818 EVM GUI Installation. Click Finish.

Figure 17. Installation Complete

20. A readme window as shown in Figure 18 appears displaying the link for LV 2014 RTE.

http://www.ti.com
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Figure 18. Readme Window

WARNING
The DRV8818 EVM GUI requires the LabVIEW Run-Time Engine
2014 to be installed before the GUI executes. Please note the
application is not compatible with other versions of LabVIEW
Runtime Engine.

You can download National Instruments LabVIEW Run-Time Engine 2014
from the below link:
LabVIEW Run-Time Engine 2014

NOTE: DRV8818 EVM GGUI executable has been built in LabVIEW 2014 (32-bit) version, and it
expects the LabVIEW Run-Time Engine version to be LabVIEW Run-Time Engine (32-bit
version).

3 Menu Options
• File - The File menu contains the option Exit as shown in Figure 19 below.

Figure 19. File Menu

• Debug - The Debug option can be used for the following operations.
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Figure 20. Debug Menu

•
– Demo - By selecting the Demo in the submenu, the GUI runs in simulation mode, and by

unselecting it, the GUI runs in connected mode.
– Log to File - The log to file submenu is used to log the GUI activities to a log file that is specified.
– Debug log - The Debug log option enables to log all the activities of the user. If that is not selected,

only the high-level operations log.
• View - Select View-> Schematics->DRV8818 to view the GUIs schematics

Figure 21. Schematic

• Help
– Clicking the About in the Help Menu

Figure 22. Help Menu

– The About Page provides the details like the Name of the GUI, GUI version, Supported OS and

http://www.ti.com
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Copyright Information.

Figure 23. About Page

4 Windows Application
The DRV8818 Windows application is the software counterpart for the DRV8818EVM. This application is
in charge of connecting to the MSP430 microcontroller by an USB connection, which in turn selects the
proper logic state for the DRV8818 control signals.

The design of the graphical user interface (GUI) allows for all of the DRV8818 device’s functionality to be
tested without having to intervene with the hardware, except for the proper configuration of jumpers, when
necessary.

Figure 24 shows the DRV8818EVM.exe main screen. It contains menu items to configure and enable and
disable the serial port, frames with GPIO control for the DRV8818 Control Signals, Stepper Motor control
for start and stop and speed, and current and decay control through the MSP430 DACs.
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Figure 24. DRV8818EVM.exe Main Screen

4.1 Connecting the EVM
The GUI auto-detects the port to which the USB has connected on connection of the USB cable between
the EVM and an available port on your PC. This is displayed in the window. Click the Connect button. If
this does not work, possible sources of error are as follows:
• FTDI drivers were not installed properly and the FTDI-USB chip is not recognized. Check for

connection in Control Panel→System→Hardware→Device Manager→Ports for a valid connection.
• Close the GUI, and reopen it to properly identify the open port.

4.2 Initial Configuration
First, go into the File menu. Select File→Configure Parameters, and the following box displays:
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Rsense shows the default of 100. If any modifications are made to the EVM, be sure to change these
fields so that current is properly regulated.

4.3 Operating the GUI

4.3.1 Pin Information Control
Control pins appear in RED or GREEN. Click on these pins to change the state of the pin; this shows the
current state. Using the following key, you can see that a RED color indicates that the pin is a logic low,
and a GREEN color indicates it is logic high.
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4.3.2 Basic Configuration and Control Buttons
Whereas clicking the individual pins changes the state of the pins, you can also use the control boxes at
the bottom to change the state of the pins.

For example, click on the Full Step radio button in the bottom right corner of the highlighted box. What
happens to the picture on the top?

4.3.3 Current Control and Decay Modes
This set of boxes controls the reference current and the current decay modes once this current threshold
is reached.
• Decay Control: The slider allows you to control the voltage on the DECAY pin. This controls which

mode the device is in when the current is decreasing through the load on the falling edge of the
sinusoidal current. In FULL Step mode, this control does not apply. The table shows the modes as it
corresponds to the voltage applied on the DECAY pin. For example, a voltage less than 0.7 V fixes the
device in a Fast decay mode. A voltage greater than 2 V puts the device in a Slow decay more. A
voltage between 0.7 V and 2 V selects a mixed decay with a ratio of fast decay followed by slow decay
depending on the voltage set between 0.7 V and 2 V. This is easier to see on an oscilloscope capture.

• Current Control: This slider sets the voltage on VREF. The current displays on the screen based on
the following calculation:

Iref = Vref / 8 × Rsense
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4.3.4 Motion Control
Constant Speed Mode:
• Starting Speed (PPS): The following discussion defines pulses-per-second or PPS. A pulse is a single

step in the logic table. This is not necessarily a mechanical step. If you change micro-stepping modes,
you must double this for the same speed (in 1/2 step), x4 for 1/4 step, and so on.

• Desired Speed (PPS): This is the final speed that the motor ramps to and holds, otherwise known as
the target speed.

• Acceleration Rate (PPSPS): This is how fast the device ramps from the starting speed to the desired
speed. This is also the deceleration rate once you pause stepping.

• Start Steps Button: Press this button to spin. Press it again to stop, or pause, spinning.
• Update Speed Button: While spinning, you can change the Desired Speed field and nothing will

happen until you click Update Speed.

Indexing Mode:
• # of Steps: In Full Step mode, this is the number of mechanical steps you want to take. For example,

if the motor on your bench has 200 steps in a revolution and you want to move one revolution, you
choose 200 steps. If you are in 1/2 step mode, you need to double this to 400 for a full revolution.

• Steps To Stop: When the number of steps taken achieves this point, the motor starts to decelerate at
the rate given in the Acceleration Rate field.

• Stopping Speed: After the steps in the Steps To Stop field is reached and the motor begins to
decelerate, the motor rotates at this speed (once it is reached) until the value in the # of Steps is
reached.

• Move Steps Button: Click this to begin indexing. Once indexing is complete, you can click it again to
repeat the cycle.
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5 Schematic and Bill of Materials

5.1 Schematics

Figure 25. Schematic 1 of 2
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Figure 26. Schematic 2 of 2

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLVU681A


Schematic and Bill of Materials www.ti.com

24 SLVU681A–February 2012–Revised July 2019
Submit Documentation Feedback

Copyright © 2012–2019, Texas Instruments Incorporated

DRV8818EVM Evaluation Module

5.2 Bill of Materials

QTY Designator Value Description Manufacturer MFG Part Number
11 C1, C2, C3, C5, C6, C10,

C14, C15, C17, C19, C23
0.1 uF Capacitor Kemet C0805C104K5RACTU

1 C4 100 uF 100 uF, 50 V Electrolytic Cap Panasonic ECA-1HM101
3 C7, C8, C9 .22 uF Capacitor Kemet C0805C224K5RACTU
3 C11, C12, C13 1000 pf Capacitor Kemet C0805C102K5RACTU
3 C16, C18, C22 10 uF 10 uF, 25 V Electrolytic Cap (Radial) Nichicon UVR1E100MDD
2 C20, C21 33 pF Capacitor Yageo CC0805JRNP09BN330
3 D1, D10, D11 LED RED LED RED Clear 1206 SMD Stanley Electric & Co HBR1105W-TR

DNI D2, D3, D4, D5, D6, D7, D8,
D9

MBR360 3 A, 60 V, Schottky Diode On Semiconductor MBRS360T3G

1 J1 2 Pos Terminal Block, 2 Pos, 200 mil pitch On Shore Technology Inc. OSTTA024163
1 J2 4 Pos Header Single Line, 4 Pos, 100 mil pitch Header Connector Sullins PBC04SAAN
1 J3 4 Pos Terminal Block, 4 Pos, 200 mil pitch On Shore Technology Inc. OSTTA044163
1 J4 USB B USB B Style Connector Molex 67068-8000
1 J5 14 Pos Header Header, 7-Pin, Dual row, Right Angle Sullins PBC07DAAN
1 J6 9 Pos Header Control Sullins Connector Solutions PBC09SAAN
1 JMP1 3 Pos Header Single Line, 3 Pos, 100 mil pitch Header Connector Sullins PBC03SAAN
2 JP1, JP6 3 Pos Header Single Line, 3 Pos, 100 mil pitch Header Connector Sullins PBC03SAAN

DNI JP2, JP3, JP4, JP5 2 Pos Header Single Line, 2 Pos, 100 mil pitch Header Connector Sullins PBC02SAAN
1 JP14 0.230" (5.84mm) Two Pin Jumper Sullins Connector Solutions PBC02SAAN
1 L1 10 mH Ferrite Bead 1.5A 40 ohm 0805 SMD Steward MI0805K400R-10
1 PCB1 N/A CPG001 PCB Bare Board N/A N/A
2 R1, R2 0.1 Resistor Bourns CRA2512-FZ-R100ELF
1 R3 2.2 K Resistor Yageo RC0805JR-072K2L
2 R4, R6 5 K Potentiometer Murata Electronics PV37Y502C01B00
2 R5, R7 47 K Resistor Yageo RC0805JR-0747KL
1 R8 4.7 K Resistor Yageo RC0805JR-074K7L
2 R9, R10 330 Resistor Yageo RC0805JR-07330RL
1 R11 196 K Resistor Yageo 9C08052A1963FKHFT
1 R12 110 K Resistor Yageo RC0805JR-07110KL
9 R101, R102, R103, R104,

R105, R106, R107, R108,
R109

3300 Resistor Yageo RC0603FR-073K3L

1 S1 Push Button Switch Panasonic EVQ-11A04M
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QTY Designator Value Description Manufacturer MFG Part Number
23 TP1, TP2, TP3, TP4, TP5,

TP6, TP7, TP8, TP9, TP10,
TP11, TP12, TP13, TP14,
TP15, TP16, TP17, TP18,
TP19, TP20, TP21, TP22,
TP30

Test Stake White Glass Beaded Test Point Kobiconn 151-101-RC

5 TP23, TP26, TP27, TP28,
TP29

Test Stake Black Glass Beaded Test Point Kobiconn 151-103-RC

2 TP24, TP25 Test Stake Red Glass Beaded Test Point Kobiconn 151-107-RC
1 U1 Driver Bipolar Stepper Motor Driver With Indexer Texas Instruments DRV8818PWP
1 U2 USB Driver USB Chip FTDI 604-00043
1 U3 MSP430 MCU MSp430 Microcontroller Texas Instruments MSP430F2617TPMR
1 U4 LDO 750 mA LDO 8-SOIC Texas Instruments TPS77701D
1 Y1 Crystal Crystal Oscillator ECS Inc. ECS-80-20-4

http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLVU681A


26 SLVU681A–February 2012–Revised July 2019
Submit Documentation Feedback

DRV8818EVM Evaluation Module

http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SLVU681A


www.ti.com Schematic and Bill of Materials

27SLVU681A–February 2012–Revised July 2019
Submit Documentation Feedback

Copyright © 2012–2019, Texas Instruments Incorporated

DRV8818EVM Evaluation Module

IMPORTANT NOTICE AND DISCLAIMER

TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS”
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD
PARTY INTELLECTUAL PROPERTY RIGHTS.
These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable
standards, and any other safety, security, or other requirements. These resources are subject to change without notice. TI grants you
permission to use these resources only for development of an application that uses the TI products described in the resource. Other
reproduction and display of these resources is prohibited. No license is granted to any other TI intellectual property right or to any third
party intellectual property right. TI disclaims responsibility for, and you will fully indemnify TI and its representatives against, any claims,
damages, costs, losses, and liabilities arising out of your use of these resources.
TI’s products are provided subject to TI’s Terms of Sale (www.ti.com/legal/termsofsale.html) or other applicable terms available either on
ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable
warranties or warranty disclaimers for TI products.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated
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STANDARD TERMS FOR EVALUATION MODULES
1. Delivery: TI delivers TI evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or

documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.
1.1 EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility

evaluation, experimentation, or scientific analysis of TI semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

1.2 EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

2 Limited Warranty and Related Remedies/Disclaimers:
2.1 These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License

Agreement.
2.2 TI warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date TI delivers such EVM

to User. Notwithstanding the foregoing, TI shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (c) User has not paid on time. Testing and other quality control
techniques are used to the extent TI deems necessary. TI does not test all parameters of each EVM.
User's claims against TI under this Section 2 are void if User fails to notify TI of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

2.3 TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by TI and that are determined by TI not to conform to such warranty. If TI elects to repair or
replace such EVM, TI shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

WARNING
Evaluation Kits are intended solely for use by technically qualified,
professional electronics experts who are familiar with the dangers

and application risks associated with handling electrical mechanical
components, systems, and subsystems.

User shall operate the Evaluation Kit within TI’s recommended
guidelines and any applicable legal or environmental requirements
as well as reasonable and customary safeguards. Failure to set up

and/or operate the Evaluation Kit within TI’s recommended
guidelines may result in personal injury or death or property
damage. Proper set up entails following TI’s instructions for

electrical ratings of interface circuits such as input, output and
electrical loads.

NOTE:
EXPOSURE TO ELECTROSTATIC DISCHARGE (ESD) MAY CAUSE DEGREDATION OR FAILURE OF THE EVALUATION
KIT; TI RECOMMENDS STORAGE OF THE EVALUATION KIT IN A PROTECTIVE ESD BAG.
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3 Regulatory Notices:
3.1 United States

3.1.1 Notice applicable to EVMs not FCC-Approved:
FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.
3.1.2 For EVMs annotated as FCC – FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION
This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.
Changes or modifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

FCC Interference Statement for Class B EVM devices
NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

3.2 Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247

Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:
(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) l'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de l'appareil doit
accepter tout brouillage radioélectrique subi, même si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:
Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

http://www.ti.com
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Concernant les EVMs avec antennes détachables
Conformément à la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique à l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à l'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d’usage et ayant un gain admissible maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour l'exploitation de
l'émetteur

3.3 Japan
3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page 日本国内に

輸入される評価用キット、ボードについては、次のところをご覧ください。
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by TI as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):
1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal

Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.

【無線電波を送信する製品の開発キットをお使いになる際の注意事項】 開発キットの中には技術基準適合証明を受けて
いないものがあります。 技術適合証明を受けていないもののご使用に際しては、電波法遵守のため、以下のいずれかの
措置を取っていただく必要がありますのでご注意ください。
1. 電波法施行規則第6条第1項第1号に基づく平成18年3月28日総務省告示第173号で定められた電波暗室等の試験設備でご使用

いただく。
2. 実験局の免許を取得後ご使用いただく。
3. 技術基準適合証明を取得後ご使用いただく。

なお、本製品は、上記の「ご使用にあたっての注意」を譲渡先、移転先に通知しない限り、譲渡、移転できないものとします。
上記を遵守頂けない場合は、電波法の罰則が適用される可能性があることをご留意ください。 日本テキサス・イ

ンスツルメンツ株式会社
東京都新宿区西新宿６丁目２４番１号
西新宿三井ビル

3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
電力線搬送波通信についての開発キットをお使いになる際の注意事項については、次のところをご覧ください。http:/
/www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page

3.4 European Union
3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.

http://www.ti.com
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_01.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
http://www.tij.co.jp/lsds/ti_ja/general/eStore/notice_02.page
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4 EVM Use Restrictions and Warnings:
4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT

LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.
4.2 User must read and apply the user guide and other available documentation provided by TI regarding the EVM prior to handling

or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:
4.3.1 User shall operate the EVM within TI’s recommended specifications and environmental considerations stated in the user

guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a TI
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a TI field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User’s handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent TI provides information on the availability and function of EVMs, TI attempts to be as accurate
as possible. However, TI does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.

6. Disclaimers:
6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT

LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." TI DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

7. USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

http://www.ti.com


www.ti.com

5

8. Limitations on Damages and Liability:
8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,

INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO TI BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

9. Return Policy. Except as otherwise provided, TI does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

10. Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and TI may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated
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IMPORTANT NOTICE AND DISCLAIMER

TI PROVIDES TECHNICAL AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES “AS IS”
AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS AND IMPLIED, INCLUDING WITHOUT LIMITATION ANY
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF THIRD
PARTY INTELLECTUAL PROPERTY RIGHTS.
These resources are intended for skilled developers designing with TI products. You are solely responsible for (1) selecting the appropriate
TI products for your application, (2) designing, validating and testing your application, and (3) ensuring your application meets applicable
standards, and any other safety, security, or other requirements. These resources are subject to change without notice. TI grants you
permission to use these resources only for development of an application that uses the TI products described in the resource. Other
reproduction and display of these resources is prohibited. No license is granted to any other TI intellectual property right or to any third
party intellectual property right. TI disclaims responsibility for, and you will fully indemnify TI and its representatives against, any claims,
damages, costs, losses, and liabilities arising out of your use of these resources.
TI’s products are provided subject to TI’s Terms of Sale (www.ti.com/legal/termsofsale.html) or other applicable terms available either on
ti.com or provided in conjunction with such TI products. TI’s provision of these resources does not expand or otherwise alter TI’s applicable
warranties or warranty disclaimers for TI products.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2019, Texas Instruments Incorporated

http://www.ti.com/legal/termsofsale.html
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